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Drake Software User’s Manual Supplement: 990
Copyright
The 2010 Drake Software Manual Supplement: Charities and Non-Profits, Drake Tax 
Software, and any other related materials are copyrighted material. All rights are 
reserved by Drake Enterprises, LTD, including all ownership rights. This document, 
associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and repro-
duce the material in this document in an unaltered form only for your personal, non-
commercial use or for non-commercial use within your organization. Copyright, 
trademark, and other proprietary notices may not be removed.

© 2010 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, 
there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, 
assumes no liability for damages or claims resulting from the use of the information 
contained herein.

Trademarks
The Drake Software Logo and Drake Tax are registered trademarks of Drake 
Enterprises, LTD.

Other product names mentioned in this manual may be trademarks or registered 
trademarks of their respective companies.
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Charities and Non-profits (990)

Data entry on a tax-exempt organization (990) return is the same as data entry on the 
1040. Help, shortcut keys, and navigation through data entry all function as they do in 
the 1040. See Drake Software User’s Manual: Tax Year 2010 for the basics of using 
the program. 

What’s New in Drake for Charities and Non-Profits
Drake programs its tax software according to the latest IRS rules and regulations. The 
2010 program reflects all IRS changes to credits and deductions, including discontinu-
ations. For specific details to the IRS’s changes, see the IRS instructions for individual 
forms for tax-exempt organizations.

The following sections list some of the main changes to the 990 package for 2010.

General Changes
The following changes have been made in various packages within Drake’s tax soft-
ware for 2010:

• More Screen-to-Screen Hyperlinks — New hyperlinks have been added within 
the 990 package. These links allow you to access related screens—and return to 
the original screen—without the intermediate step of opening the Data Entry 
Menu.

• Improved EF Messages and NOTES Pages — Many of the EF message and 
NOTES pages have been rewritten for improved clarity and to better help with 
troubleshooting returns.

• Improved Calculation Results Window — The Calculation Results window 
now contains more links to EF messages and enhanced messages.

• New EF Messages for Accepted Returns — For returns that have been e-filed 
and accepted by the IRS, the program produces EF messages to remind you not to 
file the return again.
Tax Year 2010 1



What’s New in Drake for Charities and Non-Profits Drake Software User’s Manual
Form and Screen Changes
Form and screen changes to the 990 package include:

• Multiple Forms 8027 Available — Returns can now include multiple Forms 
8027, Employer’s Annual Information Return of Tip Income & Allocated Tips.

• Form 8941 — As with the 1040 package, Form 8941, Credit for Small Employer 
Health Insurance Premiums, has been added. Use screen 8941 to complete infor-
mation for this credit.

• Schedule A Worksheet — The software now produces a Schedule A worksheet 
for Part II, line 5.

• Screen W — Screen W (for Form 990-W, Estimated Tax on UBTI) is not new to 
the program, but it is now accessible from both the Form 990-T and Form 990-
PF tabs of the Data Entry Menu.

• Screen O — Screen O (for Schedule O, Supplemental Information) is not new to 
the program, but it is now accessible from the 990-EZ only section of the Form 
990/990EZ tab of the Data Entry Menu.

E-filing Changes
Form 8868, Application for Additional Extension of Time to File an Exempt Organi-
zation Return, can now be e-filed using Drake.

Printing Options
Four new printing options (located on the PRNT screen) have been added to the 990 
package for 2010:

• Change in accounting — If this box is marked, the program indicates at the top 
of the 990 form that the organization has changed its accounting period. 

• PIN for preparer’s alternative electronic signature — To be used for the cli-
ent’s and preparer’s copies of a return that has been e-filed; the PIN entered must 
match the PIN entered in Setup > Preparer(s).

• 990-T Gross receipts $10,000 or less — To be marked if the amount in Part I, 
line 13, column A is $10,000 or less. If this box is marked, all non-required fields 
on Form 990-T will be blank.

• Due date to print on letter and filing inst — An entry here overrides the default 
due date that is printed on letters and filing instructions.

For more information on individual options, go to the PRNT screen, click the option, 
and press F1 for field-level help.

NOTE Form 990-T must be used in order to report the Form 8941 credit, even 
if there is no unrelated business income.
2 Tax Year 2010



Drake Software User’s Manual Getting Started
Getting Started
Some early tasks you may need to perform when getting started on a 990 return 
include creating a return (for new clients) and updating a return (for existing clients).

Creating a Return
To create a new return in Drake:

1. From the Home window, click Open/New (or select File > Open/Create 
Returns, or press CTRL+O).

2. In the Open/Create a New Return dialog box, enter the organization’s nine-digit 
identification number.

3. Click OK. Click Yes when asked if you want to create a new return.
4. In the New Return dialog box, select Tax Exempt - 990 and enter the organiza-

tion’s name.
5. Click OK.

Screen 1 of the return is displayed. You can now begin entering header information 
for the organization.

Updating a Prior-Year Return
If you prepared the organization’s tax return last year, you need to update it for 2010.

Prior-year returns can be updated in three ways:

• A single return (updated one at a time) using Last Year Data > Update 2009 to 
2010 (recommended)

• With all other returns in the program using Last Year Data > Update 2009 to 
2010 (not recommended)

• When you open the return for the first time in the 2010 program and are prompted 
to update it

Drake recommends using the first option (updating returns individually) to ensure that 
you update only those items in a return that you want updated.

NOTE
Blank forms are a good tool for helping clients collect tax-related data 
you will need. To access blank forms, go to Tools > Blank Forms and 
select the Tax-Exempt tab. Select a form from the list and click Print.

NOTE
Header information for all forms is completed on screen 1. For informa-
tion on specific fields in screen 1, see “Header Information (Forms 990, 
990-EZ, 990-PF, 990-T, 990-N)” on page 9.

NOTE
If you attempt to open a prior-year 990 return that was marked as “final” 
the previous year, the program informs you that the return was marked 
as final before it prompts you to proceed.
Tax Year 2010 3



Form 990-N Drake Software User’s Manual
Form 990-N
Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not 
Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organi-
zations.

To file the e-Postcard using Drake, go to screen 1 for the organization and take the fol-
lowing steps:

1. Select N - Form 990-N from the Form drop list (under the General Information 
heading).

Figure 1: Begin by selecting N - Form 990-N from the Form drop list on screen 1.

2. Under the EZ column (shown in Figure 1), mark item K to indicate that the orga-
nization’s gross receipts are normally not more than $50,000.

3. Go to the OFF screen and complete the applicable fields regarding compensation 
of officers, directors, trustees, etc., for at least one officer.

Once any message pages have been eliminated, the 990-N information can be e-filed. 
A “Form 990-N Information” page will be generated with the return for informational 
and bookkeeping purposes.

Form 990-EZ
Certain organizations can file Form 990-EZ, Short Form Return of Organization 
Exempt From Income Tax, instead of Form 990. For tax years beginning in 2010, if an 
organization’s gross receipts (total amounts received from all sources during its 
annual accounting period) are less than $200,000 and total assets at year-end are less 
than $500,000, it can file Form 990-EZ instead.

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 18.
4 Tax Year 2010



Drake Software User’s Manual Form 990-PF
Form 990-EZ Screens
The following screens are specifically provided for completing Form 990-EZ. They 
are grouped under the 990-EZ only heading under the Form 990/990EZ tab.

Form 990-PF
Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 
990-PF instructions for specific information on who must file this form.

Form 990-PF Screens
The 990-PF–specific screens are located under the Form 990PF tab (Figure 2).

Figure 2: Form 990PF tab in Drake (partial menu)

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

21 Part I, Revenue and Expenses

22 Parts II and III, Balance Sheet/Accomplishments

23 Part V, Other Information, Page 1

24 Part VI, Section 501(c)(3) Only

O Schedule O, Supplemental Information

SCH3 Other Items

SCH5 Part I, Line 5c

SC21 Unreported Activities

SC40 Part I, Grants and Similar Amounts Paid

SC42 Part II, Other Assets/Liabilities

NOTE
Screen O (for Schedule O, Supplemental Information) is identical to the 
SCH2 screen used for other 990 returns. To indicate that the supple-
mental note is for Schedule O, select the appropriate schedule and line 
from the Schedule drop list on screen O.

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 18.
Tax Year 2010 5



Form 990-PF Drake Software User’s Manual
Several screens, such as screen 1, the IND and OFF screens, and certain schedule 
(SCH or SC) screens, can also be found elsewhere in the menu, as they apply for mul-
tiple forms and not just the 990-PF.

Recommended Order for Completing Form 990-PF
The IRS recommends completing Form 990-PF in the following sequence to limit 
jumping from one part of the form to another. 

Part I 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in 
Table 2):

• Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.
• Line 10c (Gross profit or loss) — Use screen SCH7.
• Line 11 (Other income) — Use screen SC50 for subsidiary schedule.

Table 2: Form 990-PF, Recommended Order

Seq. Section Screens Notes

1 IV 55

2 I and II 52, 53, 54 For required schedules, see “Part I Addi-
tional Schedules” and “Part II Additional 
Schedules” (following).

3 Heading 1

4 III SCH3

5 VII-A 57 Use screen SC57 to create a schedule for 
controlled entities.

6 VIII OFF Use the IND screen to enter data for inde-
pendent contractors.

7 IX-A through X 59 If an explanation is required for line 1e of 
Part X, use screen SC59, Reduction Expla-
nation.

8 XII, lines 1–4 60 Line 4 is calculated automatically in Drake.

9 V and VI 56

10 XII, lines 5–6 n/a Calculated automatically in Drake.

11 XI 60

12 XIII 61

13 VII-B 58

14 XIV – XVII 62–66

NOTE This information is also available from the FAQ screen, item K (“Rec-
ommended Order for Completing Form 990-PF”).
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Drake Software User’s Manual Form 990-T
• Line 19 (Depreciation) — Use screen SC51 for depreciation schedule.
• Line 23 (Other expenses) — Use screen SC50 for subsidiary schedule; use screen 

SC52 for amortization schedule.

Part II 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 
in Table 2):

• Line 7a (Other notes/loans receivable) — Use screen SC14. (Us screen SCH3 for 
line 7b.)

• Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.
• Lines 10a – 10c (Investments) — Use screen SC54.
• Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.
• Line 21 (Mortgages and other notes payable) — Use screen SC55.
• Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using 
Screen SCH2

Screen SCH2, Supplemental Information and General Explanation Attachment, 
allows you to attach explanations for certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached 
statement. To select a section of a form, choose an option from the Schedule drop list 
at the top of screen SCH2. Next, write an explanation in the Explanation field. Press 
PAGE DOWN as needed for additional attachments. Note that there is a 5,000-character 
limit for e-filing.

Form 990-T
Form 990-T, Exempt Organization Business Income Tax Return, is used for:

• Reporting unrelated business income and tax liability
• Reporting proxy tax liability
• Claiming a refund paid by either a regulated investment company (RIC) or a real 

estate investment trust (REIT) on undistributed long-term capital gain
• Requesting a credit for certain federal excise taxes that have been paid
• Claiming Form 8941 credit for small-employer health insurance premiums

Based on the items listed above, an organization may need to complete Form 990-T in 
addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to 
determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

NOTES

The SCH2 screen can be used for other 990 return types. Note that 
screens O (for Schedule O, Supplemental Information) and SCH2 are 
the same.
If X (General Explanation Attachment) is selected from the Schedule 
drop list, the attachment will be e-filed with an e-fileable return (990, 
990-EZ, or 990-PF).
Tax Year 2010 7



Form 990 Drake Software User’s Manual
Form 990-T Screens
All 990-T–specific screens are located under the Form 990T tab.

Figure 3: Form 990T tab in Drake (partial menu)

Form 990
Form 990 must be filed by a tax-exempt organization under section 501(a) if it has 
either:

• Gross receipts of $1 million or more
• Total assets of $2.5 million or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions pub-
lished by the IRS.

Recommended Order for Completing Form 990
The sequence shown in Table 3 is suggested for efficiently completing a return for a 
tax-exempt organization. In general, complete the core form first, and then com-
plete—alphabetically—Schedules A through O and Schedule R, except as specified 
below. This order limits the need to jump back and forth from one part of the form to 
another, as certain later parts are required in order to complete earlier parts.

NOTE
Screen 80 must include a selection for item G (organization type) in 
order for Form 990-T to be produced correctly, with the appropriate tax 
calculated.

Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

1 A – F; H(a) – M 
(heading)

1 This is the “Heading” section of Form 
990; line M is completed automatically 
based on resident state entered.

2 Schedule R R, R2, R3 Determine related organizations, disre-
garded entities, and joint ventures for 
which reporting will be required. (See 
Sch. R instructions; Form 990 instruc-
tions, Appendix F, Disregarded Entities 
and Joint Ventures).

3 Part VII, Section A OFF
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Drake Software User’s Manual Form 990
Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)
Use screen 1 to fill out the header section for a tax-exempt organization. Complete all 
applicable fields. Enter the organization’s ID number name, address, and telephone 
number at the top of screen 1.

Foreign 
Address

If the organization has a foreign address, fill out the applicable fields in the Foreign 
Address ONLY section of screen 1.

Type of Form To indicate which form the organization is filing, select an option from the Form drop 
list on screen 1. (See Figure 1 on page 4 and Figure 4 on page 10.) If the only return 
being prepared is a 990-T and its related forms, mark the 990-T only box.

Form 
Columns

Screen 1 has separate columns indicating the header boxes for Forms 990, 990-EZ, 
and 990-PF. For example, the “Exemption application pending” item is Box B on 
Forms 990 and 990-EZ, and Box C on Form 990-PF. Note that not all questions are 
required for all forms.

4 Part VIII, IX, and X 8, 9, and 10

5 Header line G 1 Completed automatically in Drake

6 Parts III, V, VII, 
and XI

3, 4, 6, IND, 11

7 Schedule L L Complete if required; see Schedule L 
instructions.

8 VI 7 Transactions reported on Schedule L 
are relevant to determine independence 
of members of the governing body under 
Form 990, Part VI, line 1b.

9 I 2 Complete based on information derived 
from other parts of the form.

10 IV 5 Complete this section to determine 
which schedules must be completed.

11 Schedule O and 
any other applica-
ble schedules

Schedules A – 
G and Sched-
ules H – R tabs

12 II PIN; Setup info See “Part II, Signature Block” on 
page 18.

Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

NOTE
Header information to be completed first are items A through F and 
H(a) through M. The Gross receipts field (header item G on the 990) is 
completed automatically.
Tax Year 2010 9



Form 990 Drake Software User’s Manual
Figure 4: Screen 1 shows header labels for different forms (1);
not all questions are required for all forms (2).

Affiliate 
Listing 

(990 Only)

If the 990 is a group return filed for affiliates but not all affiliates are included, a list of 
affiliates must be attached to the return. Screen SCH4 is available for this purpose and 
includes fields for affiliate name, address, and EIN.

Tax Year The program uses the current calendar tax year (beginning January 1 and ending 
December 31) by default. If the organization uses a fiscal year, enter the beginning 
and end dates in the If not calendar year box on screen 1 (Figure 5).

Figure 5: If not calendar year box on screen 1

Schedule R
Once you have completed the header information on screen 1, the IRS recommends 
completing Schedule R, Related Organizations and Unrelated Partnership. Schedule R 
is used to submit data regarding the organization’s relationships with other organiza-
tions, both taxable and exempt. The program has three screens for Schedule R, listed 
in Table 4.

NOTE
The Name Control field default on screen SCH4 is the four-letter code 
used by the IRS to match the information. This is an override field and 
must be completed if name of the affiliate has changed since the 
entity’s last-filed return.

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

R Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organiza-
tions), and III (Related Organizations Taxable as a Partnership)
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To enter more entities, press PAGE DOWN to access new, blank fields.

Part VII, Section A
Once you have completed Schedule R, the IRS recommends completing Part VII, Sec-
tion A (“Compensation of Officers, Directors, Trustees, Key Employees, Highest 
Compensated Employees, and Independent Contractors”). Use the OFF screen to 
report this information, noting that information entered there is used to generate Part II 
of Schedule J (“Compensation Information”).

When completing the OFF screen, be aware that the Columns D & E and Column F 
sections must be completed.

Figure 6: Complete all fields for columns D, E, and F of the OFF screen.

If an amount is zero, enter a zero (0).

Parts VIII, IX, and X
Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting 
purposes. These sections are accessed from screens 8, 9, and 10 of the program.

R2 Schedule R, Parts IV (Related Organizations Taxable as a Corporation or 
Trust), V (Transactions With Related Organizations), and VI (Unrelated Orga-
nizations Taxable as a Partnership)

R3 Schedule R, Part V, Line 1

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

NOTE
Schedule R is not required for all organizations. For information on 
which aspects of Schedule R must be completed by an organization, 
see the IRS instructions for Schedule R. See also screen-level help in 
Drake for screens R, R2, and R3.

NOTE Use the IND screen to enter information about compensation of inde-
pendent contractors.
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Statement of 
Revenue

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to 
complete items 1 and 3 through 10. Press PAGE DOWN (or click the Lines 2 11 screen 
hyperlink) to access fields for items 2 (“Program Service Revenue”) and 11 (“Miscel-
laneous Revenue”).

Statement of 
Functional 
Expenses

Use the organization’s normal accounting method to complete Part IX, Statement of 
Functional Expenses. Part IX should not be used to report expenses that belong on 
lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

Part IX has two screens; to access the first screen (lines 1 though 14), go to screen 9. 
To access the second screen (lines 15 through 26), press PAGE DOWN from screen 10.

Balance 
Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used.

Part X has two screens; to access the first screen (lines 1 through 15), go to screen 10. 
To access the second screen (lines 17 through 32), press PAGE DOWN from screen 11.

Header Line G
The program calculates header line G (gross receipts) automatically based on the 
information entered in Part VIII, lines 6b (both columns), 7b (both columns), 8b, 9b, 
10b, and 12. (Part VIII figures are entered on screen 8.)

Parts III, V, VII, and XI
Once you have completed Box G of the header, the IRS recommends completing Parts 
III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, and 11).

Purpose & 
Achievement

Part III, Statement of Program Service Accomplishments, requires that the organiza-
tion report its new, ongoing, and discontinued exempt purpose achievements, along 
with any related revenue and expenses.

In Drake, Part III of Form 990 consists of two screens. Use screen 3 to answer items 1 
through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt pur-
pose achievements). From screen 3, you can access screen 4 by pressing PAGE DOWN.

Exempt 
Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s 
mission. The mission statement can address why the organization exists, what it hopes 
to accomplish, whom it intends to serve, and activities it will undertake and where. 
See IRS instructions for further information on what constitutes a mission.

NOTE The screen help in the program provides further instructions on this 
section. For additional information, see the IRS instructions.

NOTE
Some end-of-year amounts require separate schedules. Screens for 
these schedules can be accessed by clicking the applicable links on 
screens 10 and 11.
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If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to 
describe any new services or changes to services. From screen 3, you can click the 
Sch O Screen hyperlink to access this screen. See “Schedule O, Supp. Info.” on 
page 18 for more information about filling out Schedule O in the program.

Exempt 
Achievement

Enter expenses, revenue, and a description of the exempt purpose achievements on 
screen 4. Examples of exempt achievements include:

• Providing charity care under a hospital’s charity care policy
• Providing higher education to students under a college’s degree program (the 

number of students served must be indicated)
• Making grants or providing assistance to individuals who were victims of a natu-

ral disaster
• Providing rehabilitation services to residents of a long-term care facility

Acceptable exempt achievements do not include any achievement not substantially 
related to the accomplishment of the organization’s exempt purpose (other than by 
raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, 
press PAGE DOWN and continue the description. There is no need to re-enter the infor-
mation in the top section of the screen. If the description takes up more space than is 
allowed on the printed return, the program will generate it on a separate SERVICES 
page.

Figure 7: Part III of Form 990 references a SERVICES page for descriptions
that are too long to be printed on the actual 990 form.

NOTE If the organization does not have a mission that has been adopted by 
its governing body, type None as the Primary exempt purpose.
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To enter another achievement, press PAGE DOWN and mark the box labeled Check 
this box if starting a new description. The second description entered is shown (or 
referenced on a SERVICES page, if applicable; see Figure 7) in section 4b of Part III. 
A third description is printed or referenced in section 4c. Additional descriptions are 
shown on a SERVICES page generated with the return.

Other IRS 
Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show 
the organization’s compliance with the requirements of other federal tax laws for 
reporting and substantiation. Use screen 6 in the program to enter data for Part V. In 
Drake, Part V consists of two screens: use screen 6 to answer items 1 through 6b; 
press PAGE DOWN from screen 6 to access items 7 through 12.

Compen-
sation

Part VII reports compensation paid to officers, directors, trustees, key employees, 
highest-compensated employees, and independent contractors. For Form 990, 990-EZ, 
or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent 
contractors) to enter this information.

The OFF screen also has fields for entering an officer address, “books in care of” 
information, and an indication of whether the specified officer signs the return. The 
IND screen has fields for name and address, type of service, and compensation, and a 
field to enter the number of contractors paid more than $100,000 ($50,000 for 990-PF) 
in reportable compensation.

Financial 
Statements 

& Reporting

Part XI, Financial Statements and Reporting, is used for reporting information on the 
organization’s accounting methods and financial statements. The accounting method 
(line 1 of Part XI) is pulled from the method indicated on screen 1. Use screen 11 to 
answer all other items for Part XI.

Schedule L, Transactions With Interested Persons
Screen L contains fields for completing Parts I through IV of Schedule L, Transac-
tions With Interested Persons. All or part of Schedule L may be required for certain 
organizations that file Form 990 or 990-EZ. Schedule L is used for the following pur-
poses:

• Reporting information on certain financial transactions or arrangements between 
the organization and disqualified persons under section 4958 or other interested 
persons

• Determining whether a member of an organization’s governing body is an inde-
pendent member for purposes of Form 990, Part VI, line 1b (“Enter the number of 
voting members that are independent”)

For information on which organizations must complete all or part of Schedule L, see 
the screen help in the program, or consult the IRS instructions.

NOTE
The exempt achievement description has a 5,000–character limit for e-
filing; if the description exceeds 5,000 characters, the return must be 
paper-filed.
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Part VI, Governance, Management, and Disclosure
Part VI, Governance, Management, and Disclosure, requests information regarding 
the governing body and management governance policies and disclosure practices. 
Although federal tax law generally does not mandate particular management struc-
tures, operational policies, or administrative practices, every organization is required 
to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access 
Sections B and C. If additional information is required for Part VI, use Schedule O 
(screen O; see “Schedule O, Supp. Info.” on page 18).

Part I, Summary
The summary section asks for information regarding the mission, activities, and finan-
cial results of the organization. Use screen 2 to complete Form 990 Part I, Summary.

Number of 
Volunteers

Enter the number of full-time and part-time volunteers who provided volunteer ser-
vices to the organization during the reporting year. A reasonable estimate is accept-
able if an exact number is not known. If the organization wishes to provide an 
explanation of how the number was determined, use Schedule O (screen O in the pro-
gram; see “Schedule O, Supp. Info.” on page 18).

Line 7b If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.

Lines 8–19 Prior-year amounts are updated automatically from the previous year’s return. These 
amounts are shown on screen 2.

Part IV, Checklist of Required Schedules
An organization uses Part IV, Checklist of Required Schedules, to determine which 
schedules must be completed and filed with the tax return. In Drake, two screens con-
tain fields for Part IV. Open screen 5 to access fields for lines 3 through 24d. Press 
PAGE DOWN from screen 5 to access fields for lines 25a through 37.

Schedules
Use the Schedules A – G and Schedules H – R tabs to access schedules. Specific 
schedules can also be accessed using hyperlinks within screens. Click a schedule letter 
or title to open the screen for that schedule.

Schedule A Use Schedule A, Public Charity Status and Public Support, with Form 990 or Form 
990-EZ to provide information regarding public charity status and public support.

Use the following screens to enter data for Schedule A:

NOTE
Some longer schedules require more than one screen to complete. For 
example, Schedule A consists of screens A, A2, and A3. You can 
access screens A2 and A3 from the Schedule tab, or you can press 
PAGE DOWN from screen A to access subsequent screens.
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• Screen A (Part I, Reason for Public Charity Status; required by all organizations 
filling out Schedule A.)

• Screen A2 (Part I, Line 11, Information about Supported Organizations)
• Screen A3 (Parts II and III, Support Schedules)

Schedule B, 
Contributors 

Use Schedule B, Schedule of Contributors, with Form 990, Form 990-EZ, or Form 
990-PF to provide information on certain contributions reported by the organization. 
Schedule B is required for contributions from at least one contributor in excess of 
$5,000. If there are no entries for the required Schedule B fields in the program, a 
message page is generated and the return cannot be e-filed. In Drake, use screen B to 
enter Schedule B information.

Schedule C, 
Political & 
Lobbying

Schedule C is required for certain section 501(c) organizations and section 527 orga-
nizations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

• Screen C — Parts I-A, I-B, and I-C
• Screen C1 — Part I-C, line 5 (names, addresses, and EINs of 527 organizations to 

which payments were made)
• Screen C2 — Parts II-A and II-B
• Screen C3 — Parts III-A and III-B
• Screen C4 — Affiliated group information

See the IRS form instructions for who is required to file.

Schedule D, 
Financial 

Statements

Filers of Form 990 should use Schedule D to provide the required reporting for the 
categories listed in Table 5. Table 5 also shows which screens in Drake are available 
for completing specific information.

NOTES

Schedule A is required. At a minimum, amounts must be entered for the 
current year—even if the amounts are zero. If there are no entries for 
Schedule A, a message page is generated upon calculation, and the 
return cannot be e-filed.
Field- and screen-level help resources within the program provide valu-
able supplemental information and tips for completing Schedule A in 
Drake. Press F1 for field-level help. On screens A and A3, click  
Screen Help for screen-level help.

NOTE Contributor information on Schedule B is not publicly disclosed.

Table 5: Schedule D: Items Covered, and Screens Used

Category Section of 
Schedule D

Screen to Use 
in Drake

Donor-advised funds Part I D

Conservation easements Part II D

Certain art and museum collections Part III D2
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Press PAGE DOWN to go to the next Schedule D screen.

To enter data for Parts VII through X, go to screen D4 and select the applicable part 
from the Part drop list (Figure 8).

Figure 8: For parts VII through X, select the applicable part on screen D4.

Press PAGE DOWN to access a blank D4 screen and enter data for additional parts.

Schedule O, 
Supp. Info.

The IRS provides Schedule O for filers who must include narrative information for 
specific lines. Use screen O to provide narrative information for Schedule O and for 
other schedules.

To use screen O:

1. Open the screen from the Schedule tab.
2. From the Schedule drop list, select the schedule and line number(s) to be 

addressed on the screen. In the Figure 9 example, the user has selected Escrow 
Account Liability in order to address Part IV, line 2b of Schedule D.

Escrow accounts and custodial arrangements Part IV D2

Endowment funds Part V D3

Investments - Land, Buildings, Equipment Part VI D3

Investments - Land, Buildings, Equipment Part VI, line 1e 
(“Other”)

D3; click Line 1e 
detail link.

Supplemental financial information Parts VII through X D4

Supplemental financial statements Parts XI through XIII D5

Table 5: Schedule D: Items Covered, and Screens Used

Category Section of 
Schedule D

Screen to Use 
in Drake

NOTE
Note that Part VI, line 1e (“Other”) requires a separate screen from the 
previous Part VI information. To access the screen for this line, go to 
screen D3 and press PAGE DOWN.

NOTE Screen O allows you to enter narrative information for numerous sched-
ules—not just for Schedule O.
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Figure 9: Schedule drop list on screen O

3. Under Explanation, type the narrative information. Note that there is a 5,000-
character limit for e-filing.

Press PAGE DOWN to open a blank screen O and add supplemental information for 
another schedule or line.

Data entered on screen O is printed in the supplemental information section of the 
specified schedule. For example, the narrative from Figure 9 would be printed under 
Schedule D, Part XIV, Supplemental Information.

Part II, Signature Block
The signature block on Form 990 contains fields for up to two signatures:

• An officer of the organization
• The paid preparer (if applicable)

If e-filing, enter the paid preparer and organization officer PINs on the PIN screen.

Note about 
Preparer ID 

Generally, anyone who is paid to prepare the return must sign the return and fill in the 
other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of a 
filing organization is not a paid preparer.

In order to have the preparer ID number (PTIN or SSN) printed in the applicable space 
on the return, the preparer must:

• Sign the return in the space provided for the preparer’s signature

NOTES

The codes for the O screen are preceded by the letter O.
To add a narrative explanation for an amended return, select AMD 
(located just before the O items in the drop list). See “Amending a 
Return” on page 20 for more on amending a return.
To add a general explanation attachment, select X (located at the bot-
tom of the drop list).

IMPORTANT
The applicable ERO or preparer PIN must be entered in Setup > 
Preparer(s) or Setup > Firm(s) in order to e-file a tax return. For 
more information on setting up firm, preparer, and ERO informa-
tion in Drake, see Drake Software User’s Manual: Tax Year 2010.
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• Enter the preparer information
• Give a copy of the return to the organization

The paid preparer must enter the preparer’s ID number (PTIN or SSN) and the firm’s 
EIN only if filing Form 990, 990-PF, or 990-EZ for section 4947(a)(1) nonexempt 
charitable trust that is not filing Form 1041.

Filing an Extension
Calendar-year returns are due on May 16, 2011. If an organization uses a fiscal year, 
the return is due by the fifteenth day of the fifth month after the accounting period 
ends. By filing Form 8868, an organization can extend the deadline three months (to 
August 15 for a calendar year return). Form 8868 can be used to apply for an addi-
tional three-month extension if the original three-month extension was insufficient.

Use the EXT (or 8868) screen to apply for an extension. Select the applicable box at 
the top of the EXT screen to indicate the type of extension being requested.

Figure 10: Select the type of extension being requested.

If requesting an additional extension, an explanation is required on the EXT screen.

Amending a Return
Indicate an amended return on screen 1. Note that an explanation is required for an 
amended return.

IMPORTANT
The IRS is not authorized to redact (delete) the paid preparer’s 
SSN if the SSN is entered in the paid preparer’s block. Form 990 
is a publicly disclosable document. Any paid preparer whose ID 
number must be listed on Form 990 may wish to apply for and 
obtain a PTIN using Form W-7P. 

NEW FOR

 2010
Form 8868, Application for Additional Extension of Time to File an 
Exempt Organization Return, is now eligible for e-file.
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To provide an explanation for an amended return:

1. Open screen O from the Schedule A - R tab (or type O into the selector field and 
press ENTER).

2. From the Schedule drop list, select AMD - Amended Return Information. This 
selection is located between the N and O items in the Schedule drop list, as shown 
in Figure 11.

Figure 11: The AMD selection is listed between the N and O selections.

3. Enter the explanation in the text box below the drop list. Character limit for e-fil-
ing is 5,000 characters.

Binary Attachments
Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed, 
scanned into the computer, and attached to the return in order to be e-filed with it.

Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

CAUTION

When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted data. 
For more information on archiving returns, see “Archive Manager” in 
Chapter 6, “Return Results,” of the Drake Software User’s Manual: 
Tax Year 2010.

IMPORTANT The amended return should include all information pertaining to 
the return—not just the new or corrected data.

NOTE
This PDF–attachment feature is available in several packages in Drake. 
Some of the examples shown in this section are from other packages, 
but the feature works the same way in all packages.
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The PDF Attachment Process
Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached
2. Informing the program that a PDF file will be sent with the return
3. Attaching the PDF file for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Files in 

Drake

To indicate in the software that a PDF file will be sent with the return:

1. Open the return in Drake. From the Form 990/990EZ tab of the Data Entry 
Menu, click PDF, or type PDF in the selector field and press ENTER.

2. Fill out the columns on the PDF Attachments screen. See Table 6 for examples.

Table 6: PDF Attachment Window Columns

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF file is attached, the program generates an EF 
message page regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Files in Drake,” previously), there will be two PDF–
related items in the View/Print window:
• A MESSAGES alert (item #1 in Figure 12)
• An Attach PDF button on the toolbar (item #2 in Figure 12)

TIP It’s a good idea to use the DDM scanning feature for this step.

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 990

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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Figure 12: The red MESSAGES page and the Attach PDF button

2. Click MESSAGES to view EF messages, including information on how to attach 
the required documents to the return.

3. Click Attach PDF. The EF PDF Attachments window displays the information 
entered on the PDF Attachments window in data entry. A red X means the docu-
ment has not been attached; a green check mark indicates an attached document.

Figure 13: The EF PDF Attachments window

4. Click the row of a document to attach.
5. Click Browse.
6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-

ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return, the return is ready to be e-filed.

Printing Generated Documents
In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. An EF message will states 
that attachments are required. You would then need to obtain or complete the state-
ments, scan them into the computer, save them as a PDF file, and attach them to the 
return.

Using the PRNT Screen
Use the PRNT screen to override most program defaults.
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Suppressing/Forcing Items
To suppress or force printing of certain items, go the PRNT screen and select the 
desired options.Selections override the options established in Setup. For more on set-
ting up options globally in Drake, see Drake Software User’s Manual: Tax Year 2010.

The following items can be “forced” from the PRNT screen (see Figure 14):

• Diagnostic summary report listing the forms calculated and providing a brief sum-
mary of the return

• Next-year depreciation listing for the organization
• Indication on return that organization has changed its accounting period
• Preparer PIN for preparer and client copies of a return that has been e-filed

Figure 14: PRNT screen options

The following items can be suppressed from the PRNT screen of a 990 return (see 
Figure 14):

• Commas (from the amounts printed on the forms)
• Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) 

or 501(c)(4) organization (Only Column A, Total expenses, would be generated 
for this section of Form 990.)

• Ddata for non-required fields on Form 990-T of gross receipts are $10,000 or less

Overriding Other Setup Options
Filing instructions (federal and state) and envelope coversheets (organization, IRS, 
and state) can be either forced or suppressed from the PRNT screen to override the 
global setting in Setup.

You can also enter the date to be printed on the return. In Setup > Options > 
Optional Items on Return, you can indicate if the return should have no date or if it 
should have the current system date. Use the PRNT screen to override the setup 
option choice for a return.

NEW FOR

 2010
A default due date for filing is printed on all letters and filing instructions 
generated with a return. You can now override the default by entering 
an alternate due date in the Due date to print on letter and filing 
instructions field on the PRNT screen.
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Turn Off Autobalance
Autobalance forces the balance sheet to balance for both the beginning- and end-of-
year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of amounts 
being erroneously deleted or changed from the balance sheet screens. To reconcile the 
differences, it is best to compare the organization’s beginning and ending balance 
sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Electronic Filing
An organization has the option to e-file Form 990, 990-EZ, 990-PF, and related forms, 
schedules, and attachments. If the organization files at least 250 returns during the cal-
endar year and has total assets of $10 million or more at the end of the tax year, it is 
required to e-file Form 990.

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed 
instructions on e-filing returns in Drake, see Drake Software User’s Manual: Tax Year 
2010.

IRS Error Reject Codes
If the following IRS error reject code is generated when e-filing a 990 return, the pre-
parer must contact the IRS for further information. The e-file help desk number is 
(866) 255-0654.

R0000-905: Electronic Filing Identification Number (EFIN) in the Return Header 
must be listed in the e-File database and in accepted status.

F990-913: Tax-exempt status specified in Item I, must match data in the efile data-
base.

R0000-922: Filer’s EIN and Name Control in the Return Header must match data in 
the e-File database, unless “Name Change” or “Name or Address Change” checkbox 
is checked, if applicable.

R0000-032: If “Amended Return” or (Superseded for 1120/1120S/1120-F) checkbox 
is not checked, then taxpayer TIN in the Return Header must not be the same as a TIN 
of a previously accepted electronic return for the return type and tax period indicated 
in the tax return.

NOTE Form 990-T cannot be e-filed.
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G
governance, management, & disclosure 15
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H
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L
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lobbying activities (Schedule C) 16
long-term care services, provision of 13
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Form 990-PF 6

organization contact information 9
other IRS filings and tax compliance 14
override

of setup options 24

P
partnerships, unrelated (Schedule R) 10
PDF files, e-filing 20–23
PIN signatures 2, 19
political campaigns (Schedule C) 16
preparer signature 18–19
primary exempt purpose 13
prior-year returns, updating 3
private foundation return (Form 990-PF) 5–7
proxy tax liability 7
public status & support (Schedule A) 16

R
real estate investment trusts (REITs) 7
receipts, gross 12
regulated investment companies (RICs) 7
rehabilitation services 13
reject codes 25
related organizations (Schedule R) 10

required schedules, checklist of 15
returns

creating 3
updating from the prior year 3

revenue, statement of 12

S
SCH2 (attachment) screen 7
Schedule A (Public Status and Support) 2, 16
Schedule B (Schedule of Contributors) 16
Schedule C (Political Campaign and Lobbying Activities)

16
Schedule D (Financial Statements) 17
Schedule L (Transactions with Interested Persons) 15
Schedule O (Supplemental Information) 2, 18
Schedule R (Related Organizations and Unrelated Partner-

ship) 10
schedules, checklist of required 15
SERVICES pages 13
setup options, overriding 24
short-form returns (Form 990-EZ) 4–??
signature block 18–19
statement

see also financial statements
of functional expenses 12
of program service accomplishments 12
of revenue 12

summary
on Form 990, Part I 15
report printing 23

supplemental information (Schedule O) 18
suppressing commas 24

T
tax

compliance statements (Part V of Form 990) 14
excise, credit for 7
liability, reporting 7
year, specifying a 10

transactions (Schedule L) 15
type of form, selecting 9

U
unrelated business income, reporting 7
updating a prior-year return 3

V
volunteers 15
28 Tax Year 2010
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